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Kiểm Tra Nhiều Điều Kiện Trong 
Excel

Hàm IF Với Nhiều Điều Kiện 
Trong Excel

Hàm Đếm Có Điều Kiện Trong 
Excel

Hàm Tính Tổng Có Điều Kiện 
Trong Excel

Định Dạng Có Điều Kiện Trong 
Excel

Ràng Buộc và Chỉ Dẫn Nhập Liệu 
Trong Excel 

Tổng Hợp Dữ Liệu Và Tạo Báo 
Cáo Tự Động Với PivotTable

Trực Quan Hóa Dữ Liệu Với Pivot 
Chart Trong Excel

Sử Dụng AI Trong Excel

Bài Thi Cuối Khóa Môn Excel

TIN

HỌC



TIN HỌC SAO VIỆT

CHƯƠNG I: KIỂM TRA NHIỀU ĐIỀU KIỆN TRONG EXCEL

1) Hàm AND trong Excel

2) Hàm OR trong Excel

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Như đã được học ở cơ bản, mục đích của chương kiểm tra điều kiện là để phục vụ cho 
các bài toán có một điều kiện, và cụ thể là phục vụ cho hàm IF.

Chương học này sẽ tập trung vào các bài toán có nhiều điều kiện để phục vụ cho các bài 
toán có nhiều điều kiện như IF, SUMIFS, COUNTIFS, SUMPRODUCT.

I. MỤC ĐÍCH NGHIÊN CỨU

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến        ☏ 093 11 44 858                                  🌍tinhocsaoviet.com                                Trang 3



➔ Bài tập kiểm tra nhiều điều kiện với hàm AND trong Excel

➔ Bài tập kiểm tra nhiều điều kiện với hàm OR trong Excel

II. BÀI TẬP TIẾP CẬN
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1. Hàm AND Trong Excel

TIN HỌC SAO VIỆT

❖ Hàm AND được sử dụng để kiểm tra đồng thời nhiều điều kiện

❖ Kết quả hàm AND trả về TRUE khi tất cả các điều kiện đưa ra phải thỏa mãn

❖ Kết quả hàm AND trả về FALSE khi có một điều kiện bất kỳ không thỏa mãn

→ Cú pháp hàm AND: = AND(phép kiểm tra 1, phép kiểm tra 2,...)

III. NỘI DUNG NGHIÊN CỨU

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến           ☏ 093 11 44 858               🌍tinhocsaoviet.com            Trang 5



2. Hàm OR Trong Excel

TIN HỌC SAO VIỆT

❖ Hàm OR được sử dụng để kiểm tra đồng thời điều kiện

❖ Kết quả hàm OR trả về TRUE khi có một trong các điều kiện đưa ra thỏa mãn

❖ Kết quả hàm OR trả về FALSE khi tất cả các điều kiện đưa ra không thỏa mãn

→ Cú pháp hàm OR: =...OR(phép kiểm tra 1, phép kiểm tra 2,...)
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TIN HỌC SAO VIỆT

CHƯƠNG II: HÀM IF NHIỀU ĐIỀU KIỆN TRONG EXCEL

1) Hàm IF với phép kiểm tra AND

2) Hàm IF với phép kiểm tra OR

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Trong các bài toán mà kết quả trả về phụ thuộc điều kiện đưa ra, việc dùng hàm IF là phổ 
biến.

Các bài toán có kết quả trả về phụ thuộc nhiều điều kiện ràng buộc thì chúng ta kết hợp 
thêm AND, OR.

Ví dụ: 

1. Tính tiền thưởng cuối năm cho nhân viên, biết tiền thưởng phụ thuộc thâm niên và 
chức vụ

2. Tính tiền phụ cấp, biết phụ cấp chức vụ của phó giám đốc hoặc giám đốc đều là 2 
triệu.

3. Tính điểm rèn luyện cho học sinh, biết điểm rèn luyện phụ thuộc hạnh kiểm hoặc 
chuyên cần …

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập hàm IF nhiều điều kiện với  trong Excel

II. BÀI TẬP TIẾP CẬN
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1. Hàm IF Với Phép Kiểm Tra AND Trong Excel

TIN HỌC SAO VIỆT

III. NỘI DUNG NGHIÊN CỨU
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TIN HỌC SAO VIỆT

2. Hàm IF Với Phép Kiểm Tra OR Trong Excel
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TIN HỌC SAO VIỆT

CHƯƠNG III: HÀM ĐẾM CÓ ĐIỀU KIỆN TRONG EXCEL

1) Hàm COUNTIF

2) Hàm COUNTIFS

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu

TIN HỌC SAO VIỆT                            ✍Bạch Xuân Hiến           ☏ 093 11 44 858               🌍tinhocsaoviet.com            Trang 12



Hàm đếm có điều kiện dùng để đếm số lần xuất hiện của đối tượng với các điều kiện 
cho trước.

Nó rất hữu ích trong các bài toán kiểm tra giá trị trùng, đếm ngày công nhân viên, thống 
kê số lần mua hàng của khách hàng… 

Ví dụ:

1. Đếm các ngày công đi đủ của nhân viên
2. Đếm ngày đi làm nửa công
3. Tô màu các giá trị xuất hiện 2 lần… 

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập Hàm có điều kiện COUNTIF trong Excel

➔ Bài tập Hàm có điều kiện COUNTIFS trong Excel

II. BÀI TẬP TIẾP CẬN
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TIN HỌC SAO VIỆT

1. Hàm Đếm COUNTIF Trong Excel

II. NỘI DUNG NGHIÊN CỨU
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Diễn giải cú pháp

Cú pháp của hàm

Ví dụ minh họa



1. Hàm Đếm COUNTIFS Trong Excel

TIN HỌC SAO VIỆT

II. NỘI DUNG NGHIÊN CỨU
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Diễn giải cú pháp

Cú pháp của hàm

Ví dụ minh họa



TIN HỌC SAO VIỆT

CHƯƠNG IV: HÀM TÍNH TỔNG CÓ ĐIỀU KIỆN TRONG EXCEL

1) Hàm SUMIF

2) Hàm SUMIFS

3) Hàm SUMPRODUCT

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Để tổng hợp có điều kiện chúng ta dùng các hàm tính tổng có điều kiện.

Chúng ta có thể dùng hàm SUMIFS hoặc SUMPRODUCT để thay thế cho hàm SUMIF.

Các bài toán liên quan đến dạng hàm này như tổng hợp doanh số cửa hàng, tổng hợp 
công của nhân viên trong tháng, tổng hợp số lượng bán hàng trong 1 năm… 

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập hàm tính tổng 1 điều kiện SUMIF trong Excel

➔ Bài tập hàm tính tổng có nhiều điều kiện SUMIFS trong Excel

➔ Bài tập hàm tính tổng có nhiều điều kiện SUMPRODUCT trong Excel

II. BÀI TẬP TIẾP CẬN
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TIN HỌC SAO VIỆT

1. Hàm tính tổng có một điều kiện SUMIF Trong Excel

III. NỘI DUNG NGHIÊN CỨU
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Diễn giải cú pháp

Cú pháp của hàm

Ví dụ minh họa



2. Hàm tính tổng có nhiều điều kiện SUMIFS Trong Excel

TIN HỌC SAO VIỆT
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Diễn giải cú pháp

Cú pháp của hàm

Ví dụ minh họa



3. Hàm tính tổng có nhiều điều kiện SUMPRODUCT Trong Excel

TIN HỌC SAO VIỆT
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Diễn giải cú pháp



TIN HỌC SAO VIỆT

CHƯƠNG V: ĐỊNH DẠNG CÓ ĐIỀU KIỆN TRONG EXCEL

1) Tô màu tự động theo công cụ có sẵn

2) Tô màu tự động áp dụng công thức kiểm tra điều kiện  

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Với tính năng tự động định dạng dữ liệu tự động theo điều kiện đưa ra, Conditional 
Formatting giúp người dùng chủ động trong việc nhận diện các sai sót, hoặc đưa ra 
những dự báo về mặt số liệu
Ví dụ: 
+ Khi dữ liệu bị trùng lặp sẽ bị tô màu đỏ
+ Hàng tồn kho dưới mức tối thiểu sẽ bị tô màu đen
+ Công nợ sắp đến hạn phải thu thì Font chữ sẽ tô đậm, màu vàng và nền màu xanh
+ Dữ liệu lỗi sẽ tự ẩn đi
+ Dữ liệu trong tháng sẽ được tự động kẻ khung, ngoài tháng sẽ bị ẩn đi …
+ Hỗ trợ tạo báo cáo trực quan  

→ Vì vậy chúng ta cần làm nổi bật các dữ liệu quan trọng để nhận diện các rủi ro, hoặc 
tạo ra các báo cáo trực quan để đưa ra quyết định nhanh nhất cho Công ty.

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập về tô màu tự động với công cụ sẵn có trong Excel

➔ Bài tập về tô màu tự động áp dụng công thức kiểm tra điều kiện trong Excel

II. BÀI TẬP TIẾP CẬN
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TIN HỌC SAO VIỆT

1. Tô Màu Tự Động Với Công Cụ Sẵn Có Trong Excel

Chọn vùng → Home → Conditional Formatting → Highlight cells Rules → Chọn phép 
kiểm tra cần tô màu

III. NỘI DUNG NGHIÊN CỨU
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TIN HỌC SAO VIỆT

2. Tô Màu Tự Động Áp Dụng Công Thức Kiểm Tra Điều Kiện Trong Excel

Bước 1: tạo cột mới để lập công thức kiểm tra điều kiện

Bước 2: sao chép công thức kiểm tra tại ô đầu tiên

Bước 3: quét chọn vùng cần tô màu → Thao tác tiếp theo hình
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TIN HỌC SAO VIỆT

CHƯƠNG VI: RÀNG BUỘC VÀ CHỈ DẪN NHẬP LIỆU TRONG EXCEL

1) Tạo hướng dẫn nhập liệu

2) Tạo cảnh báo khi nhập liệu không đúng yêu cầu

3) Ràng buộc nhập liệu (nhập liệu theo quy định bắt buộc)

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Trong quá trình nhập liệu, nếu dữ liệu không được kiểm soát, thì rất dễ dẫn đến nhập sai

Ví dụ như:

+ Nhập dữ liệu không có trong danh mục đã quy ước

+ Nhập số điện thoại nhưng thiếu số, ví dụ sđt có 10 số nhưng lại nhập được 9 số

+ Dữ liệu chỉ cho nhập dạng số (number) nhưng lại nhập sang dạng chuỗi (text)...

→ Vì vậy, các cột dữ liệu tương ứng cần tạo ra các hướng dẫn tự động, các cảnh báo khi 
nhập không đúng yêu cầu, hoặc không chấp nhận dữ liệu nhập nếu dữ liệu không đáp 
ứng các điều kiện đưa ra.

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập tạo hướng dẫn nhập liệu

➔ Bài tập tạo cảnh báo khi nhập liệu không đúng yêu cầu

➔ Bài tập ràng buộc nhập liệu theo yêu cầu

II. BÀI TẬP TIẾP CẬN
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TIN HỌC SAO VIỆT

1. Tạo hướng dẫn nhập liệu Trong Excel

Chọn vùng → Data → Data Validation →  

III. NỘI DUNG NGHIÊN CỨU
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TIN HỌC SAO VIỆT

2. Tạo cảnh báo khi nhập liệu không đúng yêu cầu trong Excel

Chọn vùng → Data → Data Validation → Làm tiếp theo hướng dẫn trong hình 
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TIN HỌC SAO VIỆT

3. Ràng buộc nhập liệu trong Excel
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+ Any value: nhập dữ liệu bất kỳ

+ Whole number: chỉ cho nhập dữ liệu dạng số 
nguyên theo độ lớn quy ước

+ Decimal: chỉ cho nhập dữ liệu dạng số thập phân 
theo độ lớn quy ước

+ Text length: chỉ cho nhập dữ liệu với độ dài ký tự 
được quy ước

+ Date: chỉ cho nhập dữ liệu dạng ngày tháng năm 
theo độ lớn quy ước

+ List: chỉ cho nhập liệu theo danh sách quy ước

Chọn vùng → Data → Data Validation → 



TIN HỌC SAO VIỆT

CHƯƠNG VII: TỔNG HỢP DỮ LIỆU VÀ TẠO BÁO CÁO TỰ ĐỘNG VỚI PIVOTTABLE

1) Xử lý dữ liệu trước khi sử dụng PivotTable

2) Các bước tạo PivotTable

3) Các dạng tổng hợp trong PivotTable

4) Định dạng và thiết kế báo cáo trên PivotTable

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Nếu tạo báo cáo với bảng tính thông thường kết hợp với hàm, thì sẽ có một số nhược 
điểm như sau:

+ Thời gian thiết kế bảng báo cáo khá lâu

+ Bố cục cứng nhắc (thay đổi vị trí hoặc thêm dòng cột sẽ phải tính toán lại)

+ Phải thiết lập lại công thức nếu thêm điều kiện

+ Bảng tính sẽ nặng nề nếu số ô chứa công thức nhiều, đặc biệt công thức mảng

+ Chỉ có người biết nhiều về hàm và có chuyên môn trong công việc mới tạo được

→ Để giải quyết được những nhược điểm đó, PivotTable là một lựa chọn hoàn hảo, giúp 
công việc trở nên đơn giản và chuyên nghiệp hơn, kể cả người chỉ biết căn bản về Excel.

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập xử lý dữ liệu

➔ Bài tập về các bước tạo PivotTable

➔ Bài tập về các thao tác cơ bản trong PivotTable

➔ Bài tập về thiết kế báo cáo trong PivotTable

➔ Bài tập phân tích dữ liệu trong PivotTable

II. BÀI TẬP TIẾP CẬN
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TIN HỌC SAO VIỆT

1. Xử lý dữ liệu trước khi sử dụng PivotTable

+ Mỗi cột phải có một tiêu đề rõ ràng và không được trùng lặp

+ Dữ liệu cột nào phải chuẩn định dạng dữ liệu tương ứng cột đó (ví dụ: cột số lượng 
phải ở dạng Number, ngày tháng ở dạng Date…)

+ Loại bỏ các dòng trống …

III. NỘI DUNG NGHIÊN CỨU
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2. Các bước tạo PivotTable
Chọn một ô trong bảng dữ liệu → Insert → PivotTable → Làm tiếp theo hướng dẫn

 

➊ Chọn dữ liệu nguồn → ❷ Chọn vị trí hiển thị báo cáo 
+ New Worksheet: tự động tạo sheet mới và đổ bảng tổng hợp vào đó
+ Existing Worksheet: chọn 1 ô trong sheet hiện tại và đổ bảng tổng hợp vào đó
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3. Các dạng tổng hợp trong PivotTable
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➊ Tổng hợp báo cáo dạng 1 chiều

Dạng này, các cột mô tả chúng ta chỉ 
kéo vào Rows hoặc Columns, cột con 
số kéo vào Values
→ Các yêu cầu thuộc dạng này như: 
+ Tổng hợp số lượng bán theo từng 

sản phẩm

+ Tổng hợp số lượng bán từng sản 
phẩm theo từng khu vực …

Hoặc
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❷ Tổng hợp báo cáo dạng 2 chiều

Dạng này, các cột mô tả chúng ta vừa kéo vào Rows và vừa 
kéo vào Columns, cột con số kéo vào Values
→ Các yêu cầu thuộc dạng này thường xuất hiện từ 2 cột 
mô tả trở lên, ví dụ như: 
+ Phân tích tổng doanh số từng sản phẩm theo từng khu vực
+ So sánh tổng số lượng bán từng khu vực theo các tháng
+ Phân tích tổng số lượng bán các sản phẩm theo từng khu 

vực giữa các năm
+ So sánh tổng doanh thu từng tháng của 3 tháng gần nhất 

giữa các năm …
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4. Định Dạng Và Thiết Kế Báo Cáo Trên PivotTable
A. Định dạng báo cáo
Chọn một ô trong bảng báo cáo → Design → Thực hiện tiếp theo hướng dẫn
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① Định dạng tiêu đề
Row Headers: định dạng dòng tiêu đề
Column Headers: định dạng cột tiêu đề

② Tạo đường kẻ dòng, đường kẻ cột
Banded Rows: tạo các đường kẻ cho dòng
Banded Columns: tạo các đường kẻ cho cột

③ Chọn các định dạng mẫu sẵn có
👉 Kết hợp tích chọn hoặc bỏ tích chọn tại 
mục 1 và 2 khi lựa chọn mẫu tại mục 3
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B. Thiết kế báo cáo
Chọn một ô trong bảng báo cáo → Design → Thực hiện tiếp theo hướng dẫn 
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① Subtotal
Do Not Show Subtotals: không hiển thị tổng 
cộng của tổng phụ
Show all Subtotals at Bottom of Group: hiển 
thị tổng cộng dưới mỗi nhóm phụ
Show all Subtotals at Bottom of Group: hiển 
thị tổng cộng đầu mỗi nhóm phụ

② Grand Total
Off for Rows and Columns: không hiển thị tổng 
cộng các dòng và các cột
On for Rows and Columns: hiển thị tổng cộng 
các dòng và các cột
On for Rows Only: chỉ hiển thị tổng các dòng
On for Columns Only: chỉ hiển thị tổng các cột
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.
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③ Report Layout
Show in Compact Form: tất cả cột mô tả 
nằm trong một cột.
Show in Outline Form: tất cả các cột mô tả 
nằm riêng, mỗi nhóm sẽ có tổng phụ nằm 
trên đầu.
Show in Tabular Form: tất cả các cột mô tả 
nằm riêng, mỗi nhóm sẽ có tổng phụ nằm 
dưới.
Repeat All Item Labels: hiển thị lặp lại các 
dòng mô tả. Ví dụ SPL1, SPL2 ở bảng 2 bên 
cạnh, nếu chọn chức năng này nó sẽ tự hiển 
thị lặp lại ở các dòng kế tiếp.
Do not Repeat All Item Labels: chỉ hiển thị 
dòng mô tả đại diện, các dòng mô tả còn lại 
sẽ bị ẩn 
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.
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④ Blank Rows
Insert Blank Line after Each Item: chèn 
giữa các nhóm một dòng trắng
Insert Blank Line after Each Item: chèn 
giữa các nhóm một dòng trắng
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CHƯƠNG VIII: TRỰC QUAN HÓA DỮ LIỆU VỚI PIVOTCHART TRONG EXCEL

1) Các bước tạo biểu đồ trong PivotChart

2) Định dạng biểu đồ

3) Thiết kế biểu đồ

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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Để đánh giá một vấn đề chúng ta cần có các con số, tuy nhiên việc đánh giá thông qua 
các con số sẽ chậm và không thu hút bằng hình ảnh trực quan.

Chính vì vậy, biểu đồ sẽ giúp cho các con số trở nên thu hút hơn và đánh giá vấn đề 
nhanh hơn.

Một số loại biểu đồ thường sử dụng:

I. MỤC ĐÍCH NGHIÊN CỨU
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BIỂU ĐỒ CỘT BIỂU ĐỒ HÌNH TRÒN BIỂU ĐỒ ĐƯỜNG



➔ Bài tập các bước tạo biểu đồ trong PivotChart

➔ Bài tập định dạng biểu đồ

➔ Bài tập thiết kế biểu đồ

II. BÀI TẬP TIẾP CẬN
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1. Các Bước Tạo Biểu Đồ Với PivotChart

III. NỘI DUNG NGHIÊN CỨU
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Bước 1: tạo bảng tổng hợp với PivotTable

Bước 2: chọn 1 ô trong bảng → PivotTable Analyze 
→ PivotChart → Thực hiện tiếp theo hướng dẫn
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2. Định dạng biểu đồ

① Chọn vào 1 điểm trên biểu đồ → ② Format → ③ Chọn thành phần cần định dạng 
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Chart Area: nền khu vực 
chung của biểu đồ

Chart Title: tiêu đề

Plot Area: nền của khu vực 
hình ảnh

Legend: khu vực chú thích 
màu dữ liệu

→ Lưu ý:

+ Khi chọn vào từng mục 
trong danh sách xổ xuống, 
thành phần trên biểu đồ sẽ 
tự chọn.

+ Mỗi biểu đồ có thêm một số 
thành phần khác nhau.
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3. Định dạng biểu đồ

① Chọn vào 1 điểm trên biểu đồ → ② Design →  
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Ⓐ Chart Layouts: Tùy chỉnh thiết kế

+ Add Chart Element: thêm bớt các thành phần
+ Quick Layout: các kiểu bố cục sẵn có

Ⓑ Chart Styles: mẫu được định dạng sẵn 

Ⓒ Data: dữ liệu bảng tổng hợp

+ Switch row/Column: hoán đổi trục (bản chất 
là do dữ liệu bảng tổng hợp bị hoán đổi giữa 
dòng và cột dẫn đến trục biểu đồ thay đổi theo)

+ Select Data: chỉnh sửa dữ liệu

Ⓓ Type: thay đổi loại biểu đồ
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CHƯƠNG IX: SỬ DỤNG AI TRONG EXCEL

1) Một số ứng dụng AI miễn phí sử dụng cho Excel

2) Phương pháp ra lệnh cho AI trong sử dụng Excel

I. Mục đích nghiên cứu
II. Bài tập tiếp cận

III. Nội dung nghiên cứu
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“Học xong sợ bị quên”, “Hàm khó quá học không nhớ”, “Gặp một vấn đề lạ không 
biết phải hỏi ai”… 

Để giải quyết cho vấn đề trên, AI chính là một lựa chọn. Chỉ với vài câu lệnh đơn giản là 
AI có thể giúp bạn:
1. Hướng dẫn thực hiện chi tiết từng bước, có thể gợi ý thêm Video hoặc các bài viết trên mạng

2. Xử lý dữ liệu trực tiếp trên file công việc

3. Xuất dữ liệu từ hình ảnh, file PDF sang Excel theo yêu cầu

4. Tự tạo bảng dữ liệu theo yêu cầu để giải quyết các tình huống trong thực tế

5. Tạo báo cáo và phân tích dữ liệu kể khi bạn chỉ có kiến thức cơ bản nhất về Excel

I. MỤC ĐÍCH NGHIÊN CỨU
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➔ Bài tập Ứng dụng

II. BÀI TẬP TIẾP CẬN
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1. Một Số Ứng Dụng AI Miễn Phí Sử Dụng Cho Excel

III. NỘI DUNG NGHIÊN CỨU
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CHAT GPT - GEMINI - COPILOT 

Đây là 3 công cụ AI phổ biến nhất hiện nay. Phiên bản miễn phí của nó cũng đủ giúp cho người 
dùng xử lý được rất nhiều công việc khác nhau.

Bạn nên đăng ký tài khoản miễn phí để sử dụng được những tính năng hữu ích của ứng dụng như: 
cho phép xử lý trực tiếp với tệp tin, không bị giới hạn số lượng CHAT, lưu lịch sử công việc đã 
thực hiện, ghi nhớ các kiến thức.

👉CHAT GPT và GEMINI: chỉ cần có tài khoản Google (Gmail) là đăng ký sử dụng miễn phí

👉COPILOT: phải có tài khoản Microsoft (Hotmail hoặc Outlook mail…)

Ngoài ra có rất nhiều ứng dụng khác rất hữu ích khác, tuy nhiên trong giới hạn chúng ta chỉ nghiên 
cứu 3 ứng dụng này
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2. Phương pháp ra lệnh cho AI trong Excel
Để ra lệnh cho AI thì bạn thực hiện theo các bước sau:
1. Yêu cầu AI chỉ được phép ghi nhớ từng câu lệnh, chỉ thực hiện khi cho phép:

Câu lệnh: tôi sẽ cung cấp cho bạn các câu lệnh, bạn hãy ghi nhớ các câu lệnh và chưa đưa ra phản 
hồi nào, cho đến khi tôi ra lệnh OK bạn mới thực hiện.
2. Gắn AI với lĩnh vực chuyên môn cụ thể 

Câu lệnh: bạn là chuyên gia xử lý và phân tích dữ liệu trong phần mềm Microsoft Excel
3. Vấn đề cần giải quyết là gì: 

Câu lệnh: tôi cần bạn lập báo cáo tổng hợp doanh số của từng nhân viên trong tháng 5
4. Thông tin đầu vào mà bài toán có: 

Câu lệnh: tôi có bảng dữ liệu Excel gồm: tên cột 1, tên cột 2….
Bước này, có thể chỉ cần cung cấp hình ảnh là được (sử dụng Snipping Tool có sẵn trên Windows)
5. Xác nhận thực thi cho AI 

Câu lệnh: OK
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